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Test Purpose/Scope:  Test the Accounts & Profiles - Global G1 on an NIS machine.  The software that is the focus of this test is still in development.  Results for several test steps may vary from the expected results described, and some steps are currently waived.  Where any deviation from the expected results is acceptable, the step or block is shaded gray and the acceptable deviation is described.
Description:  Test global profiles and global users ONLY on a Candidate Platform operating as an NIS MASTER.
These test procedures exercise the following basic functionality, with the relevant test steps identified in parenthesis:


-Login (A), and Logout (Z)


-Setup (B)


-Create Global User with Global Profiles (C)


-Add Global Profile to an Existing User (D)


-Test Created Profiles and Necessary UNIX Permissions (E)

-Delete Global Profile from Global User (F)


-Verify Deletion of Global Profile from Global User (G)


-Test Deletion of User Account (H)


-Test Creation of User with no Default Profile (I) (Grayed Out)

-Delete the Safe Profile (if Profile Exists) (J)


-Add Account with Same Login Name/UID as Previously Deleted Account; Create Profile as Subset of Account Group (K)

-Test Session Manager Operation (when user's last profile has been deleted and a Safe Profile has not been assigned) (L)


-Test Session Manager Operation (with the existence of a Safe Profile) (M)


-Test Ability of Safe Profile to Exist with other Profiles. (N)


-Test Ability to Add Multiple Users (O)


-Test Users with Multiple Derivative Profiles (P)


-Test Interaction of Account Groups (Q)


-Test Session Manager's Ability to Resume the Previously Active Set of Profiles (R)


-Test Ability to Login with NO Available Profile.  Delete User's Only (and default) Profile (S)

-Test Ability to detect Two Users with the Same Login Name in the Same Scope (T)


-Test Ability to Detect Two Profiles with the Same Name in the Same Scope (U)


-Test Ability to Detect Two UNIX Groups with the Same Name in the Same Scope (V)


-Reset Test Cell to Original Condition (W)


-Remove NIS (X)


-Unmount/Unexport all Remotely Mounted File Systems (Y)

-Setting Up a Sun Solaris Machine as an NIS Client (Appendix A)
Overall Test Result:  The overall PASS/FAIL result for this test is determined as follows:  The overall test result is "PASS" if and only if all steps marked as PASS/FAIL steps in the Observed Result column, have a test step "PASS" result.
Test Step Results:  For each step with a "Circle One:  PASS/FAIL" in the Observed Result column, the tester compares the directly observed Candidate Platform behavior with the "PASS" criteria.  Unless other PASS criteria are noted in the test step, the test step result is "PASS" if and only if the Candidate Platform presents all of the behaviors and conditions described in the Expected Result column for that test step.  The test step result if "FAIL" if the Candidate Platform fails to satisfy any of the PASS criteria.

If the test step result is "PASS", the tester will circle "PASS" and note the actual behaviors and conditions presented in the Observed Result column.  If the observed result precisely matches the expected result, the Observed Result column for the step may contain the statement "as expected."

If the test step result is "FAIL", the tester will circle "FAIL" in the Observed Result column and note the actual behaviors and conditions presented in the Observed Result column.  Additional documentation detailing the reasons for the test step failure is included in the Validation Test Report.
Note 1:  Due to the complexity of any Candidate Platform,  it is impossible to completely specify all aspects of their operation in the space provided.  Many of the expected Candidate Platform behaviors for any test step are implicitly assumed based on industry practice, commercial testing or prior testing, and may not be explicitly described in the Expected Result column.  DISA reserves the right to consider implicit as well as explicit PASS/FAIL criteria which could adversely affect the ability of the Candidate Platform to satisfy DoD mission requirements when used as a component of the DII.

If implicit PASS/FAIL criteria are involved in a "FAIL" determination, the tester will circle "FAIL" in the Observed Result column and note the objectionable behavior in the Observed Result column at the point of observation during the test.  Additional documentation detailing the full rationale for the "FAIL" determination is to be included in the Validation Test Report.

Note2:  Test steps which are "grayed out" (i.e., the entire table row is set to a gray background) are to be considered as waived by DISA for this test version only.  Grayed out test steps are not to be executed nor is observed behavior to be recorded.  These test steps may be returned to the overall test at a future date and are retained for information purposes only.  PASS/FAIL criteria identified in these test steps will not be used in the determination of the overall test result.

Note3:  The symbol “(” (inverted triangle) denotes a blank space.  The “[RETURN]” symbol denotes a carriage return.












Test data and media required:  None.
Setup/Equipment Required:  Two Unix-based DII COE workstations.  The Candidate Platform will be configured as NIS Master, must be available to the Validation Host over the network and should be physically accessible to it.  The Validation Host will be configured as NIS Client to the Candidate Platform.  On the Validation Host, it may be necessary to use Profile Selector Configuration to allow multiple Profile Selections
Run the following commands as root on the SOLARIS Validation Host to configure NIS client:
a.
domainname nisdomain.nis

b.
ypset -c (hit return in GUI to accept kpccp as default NIS master)

c.
ypbin -broadcast
d.
edit /etc/nsswitch.conf (so that past and group entries are "files nis")

e.
cp /etc/nssswitch/conf/temp nsswitch.conf.orig/tmp/

Required Personnel:  One Tester.  The tester is assumed to be very familiar with POSIX/UNIX application platforms, but may not be familiar with Defense Information Infrastructure (DII) Common Operating Environment ( COE).



Step
Operator Action
Expected Result
Observed Result

A
Login (Optional)



A.1
Power up the Candidate Platform.
Optional: Use if not already powered up.
The DII COE login screen will appear.
Setup

A.2
On the Candidate Platform:

Login to sysadmin account using the default sysadmin and appropriate password combination.
Optional: Use if not already logged in.
Menu bar, Security Classification and CDE will appear.
Setup

A.3
Mount the KPC directory exported from the Validation Host from an xterm window.  
Type:
su -root
mount  <Validation Host>: /home1/KPC /home1/KPC
exit
Optional:  Use if not already mounted.
A message confirms that the filesystem has been mounted.
Setup

B
Setup



B.1
Export the Global Users directory on the designated NIS Master Sever.  Select, 
Hardware > Disk Manager
The Disk Manager window appears.
Circle one:  PASS  /  FAIL

B.2
Select [EXPORTFS] in the Disk Manager window.
The Export/Unexport File Systems window appears.
Circle one:  PASS  /  FAIL

B.3
Within the Export/Unexport File Systems window, Enter the appropriate options:
On Solaris, Type:  ‘root=0’     

On HP-UX, Type: ‘anon=0’       

Enter the appropriate pathname, type:

/h/USERS/global
The directory /h/USERS/global is set up on the NIS Master server as being exported.
Circle one:  PASS  /  FAIL

B.4
Click the [EXPORT] button to export the file system.
The directory /h/USERS/global is set up on the NIS Master server as being exported.
Circle one:  PASS  /  FAIL

B.5
Click [YES] to permanently export the file system.

Circle one:  PASS  /  FAIL

B.6
Confirm Step B.4
Select [EXPORTFS] in the Disk Manager window.
The Export/Unexport File Systems window appears.
Circle one:  PASS  /  FAIL

B.7
Select [CURRENT] in the Export/Unexport File Systems window.


/h/USERS/global should appear as one of the directories listed as being exported.
Circle one:  PASS  /  FAIL

B.8
Remote mount /h/USERS/global on the designated NIS Client.  Select, 
Hardware > Disk Manager
The Disk Manager window appears.
Circle one:  PASS  /  FAIL

B.9
Select [MOUNT NEW] in the Disk Manager window
The Mount File System box appears.
Circle one:  PASS  /  FAIL

B.10
Enter the following information into the corresponding boxes:

FILE SYSTEM:  <NIS Master Server name>: /h/USERS/global

MOUNT POINT:    /h/USERS/global
The file system appears in the list of mounted file systems.  (Answer 'yes' to any questions that may appear during this process.)
Circle one:  PASS  /  FAIL

B.11
Click [MOUNT] to continue.

Circle one:  PASS  /  FAIL

B.12
Click [YES] to permanently mount the file system.

Circle one:  PASS  /  FAIL

B.13
Ensure that the Candidate Platform is correctly configured as the NIS Master, and available to the Validation Host.
NOTE: (2)  ON HP Machines, auditing must be turned off first by editing the file /etc/rc.config.d/auditing and setting AUDITING = 0.  The command:  /etc/tsconvert –r must be run  immediately afterwards.  Reboot and then continue.  (To ensure changes take place, reboot even if no prompts come up.)
On the Candidate Platform, as sysadmin,
Configure DNS:  Select,

  Network > Servers > Set DNS
The DNS Setup box appears.
Circle one:  PASS  /  FAIL

B.14
Initialize NIS:  Select,   Network > Servers > Set NIS > Initialize NIS
The NIS Initialize box appears.
Circle one:  PASS  /  FAIL

B.15
Input the NIS domain name and other information as appropriate.  Type:


nisdomain.nis
A box will appear instructing that you’ve completed Steps B.1-B.17.
Circle one:  PASS  /  FAIL

B.16
Click [OK] to continue.

Circle one:  PASS  /  FAIL

B.17
When an answer box appears requesting to reboot the machine?  Click [YES] to reboot.

The machine will shutdown and go through its reboot phase.

Circle one:  PASS  /  FAIL

B.18
Verify that the Validation Host is correctly configured as a NIS Client.
NOTE (1):  Auditing must be turned off because C2 status checking must be turned off before NIS Initialization of any kind.

NOTE(2):  If the gui does not work on the Validation Host, in an xterm window, type:
Domainname<space> nisdomain.nis

ypinit –c

/usr/lib/netsvc/yp/ypbind –broadcast
NOTE(3):  ON HP Machines, auditing must be turned off first by editing the file /etc/rc.config.d/auditing and setting AUDITING = 0.  The command:  /etc/tsconvert –r must be run  immediately afterwards.  Reboot and then continue.
NOTE(4):  FOR SUN SOLARIS MACHINES RUNNING AS AN NIS client -- Please refer to the set of detailed procedures in Appendix A, " Setting up a Sun Solaris machine as an NIS Client".

Circle one:  PASS  /  FAIL

B.19
On the Validation Host:

Initialize NIS:  Select,

Network > Servers > Set NIS > Initialize NIS
The NIS Initialize box appears.
Circle one:  PASS / FAIL

B.20
Select ‘Client’, and enter both the NIS Domain name (Selected from the NIS Master Server) and the unqualified NIS Server host name.
The NIS Task Complete window will appear.
Circle one:  PASS  /  FAIL

B.21
Click [OK] to continue.
A message requesting a reboot appears.
Circle one:  PASS  /  FAIL

B.22
Click [YES] to continue.
The machine reboots as appropriate.
Circle one:  PASS  /  FAIL

C
Test basic ability to create a global user with global profiles.



C.1
On Candidate Platform NIS Server, secman:

Create a new global user using the following input criteria.

Criteria:

Scope = global

Login name = gtest1

Default profile = SSO_Default

Assigned UNIX Groups = <none>
Assigned Profiles = G:SSO_Default

If no errors are generated, the test result is PASS otherwise the result is FAIL.


Circle one:  PASS  /  FAIL

C.2
On Candidate Platform NIS Server, secman:

View user information from COE Secman, 
Security Manager: View > User by Profile > Global scope. 


If the following conditions are met, the test result is PASS otherwise the result is FAIL.

User 'gtest1' should have the G:SSO_Default profile assigned in the user-profile DB.
Circle one:  PASS  /  FAIL

C.3
On the Candidate Platform NIS Server, sysadmin:

To view  the file NIS group file, type:

ypcat group | grep gtest1 <rtn>
(NIS+) niscat group.org_dir  | grep gtest1 <rtn>
NOTE:  Prior tests have shown it is assigned to group admin by default.  Pending evaluation, this result is acceptable and should not preclude a PASS result for the test step.
User 'gtest1' should be a member of no groups in NIS group.

Circle one:  PASS / FAIL

C.4
On the Candidate Platform NIS Server, sysadmin:

To view  the file NIS passwd file, type: 
ypcat passwd  | grep gtest1 <rtn>
(NIS+) niscat passwd.org_dir  | grep gtest1 <rtn>
User 'gtest1' default GID in NIS passwd should be 36.


Circle one:  PASS  /  FAIL

D.2
Test ability to add a global profile to an existing user.



D.1
On Candidate Platform NIS Server, secman:
Assign the profile 'G:SA_Default' to the user 'gtest1'.

Criteria:

Login name = gtest1
Default Profile = <No Change>

Assigned UNIX Groups = <No Change>
Assign  Profiles = add G:SA_Default
If no errors are generated, the test result is PASS otherwise the result is FAIL.


Circle one:  PASS  /  FAIL

D.2
On Candidate Platform NIS Server, secman:

View user information from COE Secman, 
Security Manager: View > User by Profile > Global scope
If the following conditions are met, the test result is PASS otherwise the result is FAIL.

User 'gtest1' should have the G:SSO_Default and G:SA_Default profiles assigned in the user-profile DB.
Circle one:  PASS  /  FAIL

D.3
On Candidate Platform NIS Server, sysadmin:
To view the file NIS group file, type:
ypcat group | grep gtest1 <rtn>
(NIS+) niscat group.org_dir | grep gtest1 <rtn>
NOTE:  Prior tests have shown it is assigned to group admin by default.  Pending evaluation, this result is acceptable and should not preclude a PASS result for the test step.
User 'gtest1' should be a member of no groups in NIS group. 

Circle one:  PASS  /  FAIL

D.4
To view the file NIS passwd file, type:
ypcat group | grep gtest1 <rtn>
(NIS+) niscat passwd.org_dir | grep gtest1 <rtn>
User 'gtest1' default GID in NIS passwd should be 36.
Circle one:  PASS  /  FAIL

E
Test created profiles and  necessary UNIX permissions.



E.1
On Validation Host:

Login to system as 'gtest1'
Currently, the user ‘gtest1’ has a GID of 36 which was assigned via the default profile 'G:SSO_Default'. 
Circle one:  PASS  /  FAIL

E.2
Activate Profile Selector Config Icon & set Profile Selection Criteria to Multiple
The process of adding the user to the profile 'G:SA_Default' should not add them to the group 'other'.
Circle one:  PASS  /  FAIL

E.3
In Profile Selector, add the G:SSO_Default and G:SA_Default profiles (results window shows added profiles assumed).  

Criteria:

Login name = gtest1
Assigned profiles = add G:SSO_Default & G:SA_Default
‘G:SSO_Default’ is part of the SecAdm account group which is associated with the UNIX group 'admin' (GID = 36 ).
Circle one:  PASS  /  FAIL

E.4
Try to run applications from both profiles.
The ‘G:SA_Default’ profile is part of the SysAdm account group which is associated with the UNIX group 'other' (GID = 1). 


Circle one:  PASS  /  FAIL

E.5
After verifying that the expected results are received, logoff the system.

NOTE:  Pending evaluation, being able to launch applications from ‘SA_Default’ is acceptable, and should not preclude a “PASS” test step result.
Therefore, user ‘gtest1’ should be able to run applications from the G:SSO_Default profile, but not from the ‘G:SA_Default’ profile.
Circle one:  PASS  /  FAIL

E.6
On Candidate Platform NIS Server, secman:

Add UNIX group 'other' to user 'gtest1'.
Application Manager >DIIApps > L:SSO_Default > Security Manager > View User > Select 'gtest1' > Edit > Modify User 
Double-click on group 'other'
Click on [OK].
Criteria:

Login name = gtest1
Default profile = <no change>
Assigned UNIX Groups = add other
Assigned Profiles = <no change>
No errors should be generated.

User 'gtest1' should have the G:SSO_Default  and G:SA_Default profiles assigned in the user-profile DB. 


Circle one:  PASS  /  FAIL

E.7
On Candidate Platform NIS Server, sysadmin:
To view  the file NIS group file, type:
ypcat group | grep gtest1 <rtn>
(NIS+) niscat group.org_dir  | grep gtest1 <rtn>
NOTE:  Prior tests have shown it is also assigned to group admin by default.  Pending evaluation, this result is acceptable and should not preclude a PASS result for the test step.
User 'gtest1' should be a member of the group 'other' in NIS group. 
Circle one:  PASS  /  FAIL

E.8
On Candidate Platform NIS Server, sysadmin:

To view  the file NIS passwd file, type: 
ypcat passwd  | grep gtest1 <rtn>
(NIS+) niscat passwd.org_dir  | grep gtest1 <rtn>
User 'gtest1' default GID in NIS passwd should be 36.


Circle one:  PASS  /  FAIL

E.9
On Validation Host:

Log in to system as 'gtest1'

Criteria:

login name = gtest1
User 'gtest1' should now be able to launch applications from both G:SA_Default and G:SSO_Default profiles. 


Circle one:  PASS  /  FAIL

E.10
Try to run applications from both profiles.

Circle one:  PASS  /  FAIL

E.11
After verifying that the expected results are received, logoff the system.

Circle one:  PASS  /  FAIL

F
Test capability to delete a global profile from a global user.  



F.1
On Candidate Platform NIS Server, secman:

Modify user 'gtest1' by deassigning the 'G:SSO_Default' profile.

Criteria:

Login name = gtest1
Default Profile = <no change>
Assigned UNIX Groups = <no change>
Assigned Profiles = deassign 



G:SSO_Default
No errors should be generated 

User 'gtest1' should only be assigned  the ‘G:SA_Default’ profile in the user-profile DB.


Circle one:  PASS  /  FAIL

F.2
On Candidate Platform NIS Server, sysadmin:

To view  the file NIS group file, type:
typcat group | grep gtest1 <rtn>
(NIS+) niscat group.org_dir  | grep gtest1 <rtn>
NOTE:  Prior tests have shown it is also assigned to group admin by default.  Pending evaluation, this result is acceptable and should not preclude a PASS result for the test step.
User 'gtest1' should be a member of the 'other' groups in NIS group.  
Circle one:  PASS  /  FAIL

F.3
On Candidate Platform NIS Server, sysadmin:
To view  the file NIS passwd file, type: 
ypcat passwd  | grep gtest1 <rtn>
(NIS+) niscat passwd.org_dir  | grep gtest1 <rtn>
User 'gtest1' default GID in NIS passwd should be 36.


Circle one:  PASS  /  FAIL

G
Verify deletion of global profile from global user.



G.1
On Validation Host:
Login as user 'gtest1' and use the profile selector to select all profiles.  

Criteria:

Login name = gtest1
Select Profiles = <Only G:SA_Default should be available>
No errors should be generated.

User 'gtest1' should only be able to select the 'G:SA_Default' profile
Circle one:  PASS / FAIL

G.2
Attempt to launch applications from all profiles that are selected.


User should only be able to run applications from the ‘G:SA_Default’ profile.
Circle one:  PASS  /  FAIL

G.3
After verifying that the expected results are received, logoff the system.
 
Circle one:  PASS  /  FAIL

H
Test deletion of user account.



H.1
On Candidate Platform NIS Server, secman:

Delete user 'gtest1' account.

Criteria:

Login name = gtest1
No errors should be generated. 

User 'gtest1' should not be a member of any group in NIS group.
Circle one:  PASS / FAIL

H.2
On Candidate Platform NIS Server, sysadmin:

To view the file NIS group file, type:
ypcat group | grep gtest1 <rtn>

(NIS+) niscat group.org_dir | grep gtest1<rtn>
User 'gtest1' entry in NIS passwd should be removed.


Circle one:  PASS / FAIL

H.3
On Candidate Platform NIS Server, sysadmin:

To view the file NIS passwd file, type:

ypcat passwd | grep gtest1 <rtn>

(NIS+) niscat passwd.org_dir | grep gtest1<rtn>
User 'gtest1' should have no entries in user-profile database.
User's home directory (/h/USERS/global/gtest1) should be deleted.
Circle one:  PASS / FAIL

I
Test creation of user with no default profile. 
This test step is temporarily waived.
Circle one:  PASS  /  FAIL

J
Delete the Safe Profile  (If profile exists).



J.1
On Candidate Platform NIS Server, secman:

Delete the ‘Safe Profile’ if one exists in the global scope.

Criteria:

Profile = delete 'Safe Profile'
No errors should be generated.

The ‘Safe Profile’ should be deleted from the user-profile database.
Circle one:  PASS  /  FAIL

K
Test whether you can cleanly add an account with the same login name and UID as a previously deleted account.  Create a profile as a subset of an account group.



K.1
On Candidate Platform NIS Server, secman:
Create a global profile 'SSO_peon' with account group of ‘Security Admin’ and assign several applications to the profile.  

Criteria:

Scope: = global

Profile ID: = SSO_peon 

Account Group: = Security Admin
Classification: = <no change>

Profile Lock: = <no change>

Applications: = assign several
No errors should be generated.

‘G:SSO_peon’ should appear in the Profile DB.


Circle one:  PASS  /  FAIL

K.2
On Candidate Platform NIS Server, secman:
Create a global profile 'SA_peon'  with account group of ‘System Admin’ and assign several applications to the profile

Criteria:

Scope: = global

Profile ID: = SA_peon 

Account Group: = System Admin

Classification: = <no change>
Profile Lock: = <no change>
Applications: = assign several
No errors should be generated.

‘G:SA_peon’ should appear in the Profile DB.
Circle one:  PASS  /  FAIL

K.3
On Candidate Platform NIS Server, secman:
Recreate the account for user 'gtest1', this time using the default profile of 'SSO_peon'.  Don't assign any other Groups or Profiles to the user.

Criteria:

Scope = global

Login name = gtest1
Default profile = SSO_peon  
Assigned UNIX Groups = <none>
Assigned Profiles = <none>
No errors should be generated.

User 'gtest1' should have the ‘G:SSO_peon’ profile assigned in the user-profile DB
Circle one:  PASS  /  FAIL

K.4
On Candidate Platform NIS Server, sysadmin:

To view  the file NIS group file, type:

ypcat group | grep gtest1 <rtn>
(NIS+) niscat group.org_dir  | grep gtest1 <rtn>
User 'gtest1' should not be a member of any groups in NIS group.

Circle one:  PASS  /  FAIL

K.5
To view  the file NIS passwd file, type: 

ypcat passwd  | grep gtest1 <rtn>

(NIS+) niscat passwd.org_dir  | grep gtest1 <rtn>
User 'gtest1' default GID in NIS passwd should be 36.
Circle one:  PASS  /  FAIL

K.6
On Validation Host:
Login as user 'gtest1', select the 'G:SSO_peon' profile and try to run profiled applications.
No errors should be generated.

Should be able to login as user ‘gtest1’ and launch icon applications 
Circle one:  PASS  /  FAIL

K.7
After verifying that the expected results are received, logoff the system.

Circle one:  PASS  /  FAIL

L
Test Session Manager operation (when user's last profile has been deleted and a Safe Profile has not been assigned to the user).



L.1
On Candidate Platform NIS Server, secman:
Deassign the ‘G:SSO_peon’ profile from the user 'gtest1'.

Criteria:

Login name = gtest1
Assigned UNIX Groups = <no change>
Assigned Profiles = deassign  



‘G:SSO_peon’
No errors should be generated.

User ‘gtest1’ should not be assigned the ‘G:SA_Default’ profile in the user-profile DB.


Circle one:  PASS  /  FAIL

L.2
On Validation Host (NIS Client):
Login to system as 'gtest1' and examine the application launch manager window.  
Session manager should log user 'gtest1' in with no profiles available.
Circle one:  PASS  /  FAIL

L.3
Use the profile selector to select available profiles.

Circle one:  PASS  /  FAIL

L.4
After verifying that the expected results are received, logoff the system. 

Circle one:  PASS  /  FAIL

M
Test Session Manager operation  (with the existence of a Safe Profile) assigned to user ‘gtest1’.



M.1
On Candidate Platform NIS Server, secman:

Create a global 'Safe Profile' with account group of ‘Security Admin’ and assign one or more applications to it.  

Criteria:

Scope: = global

Profile ID: = Safe Profile 

Account Group: = Security Admin
Classification: = <no change>

Profile Lock: = <no change>

Applications: = assign several
No errors should be generated.

‘Safe Profile’ should appear globally in the user-profile DB under the Global scope.
Circle one:  PASS  /  FAIL

M.2
On Validation Host (NIS Client):
Login to system as 'gtest1'.  
No errors should be generated.

Session manager should log user 'gtest1' in with no profiles available.
Circle one:  PASS  /  FAIL

M.3
After verifying that the expected results are received, logoff the system.

Circle one:  PASS  /  FAIL

M.4
On Candidate Platform NIS Server, secman:
Assign the global 'Safe Profile' to user ‘gtest1’.  

Criteria:

Login name = gtest1
Default profile = <no change>
Assigned UNIX Groups = <no change>
Assigned Profiles = add G:Safe 



Profile
No errors should be generated. 

User 'gtest1' should be assigned the 'Safe Profile' in the user-profile DB.
Circle one:  PASS  /  FAIL

M.4
On Validation Host (NIS Client):
Login as user ‘gtest1’ and examine the application launch manager window


No errors should be generated.

User 'gtest1' should not be able to assume previous login profiles  (it should be empty since the last access failed.)

Circle one:  PASS  /  FAIL

M.5
Use the profile selector to select the available profiles.
The session manager should see that the user is assigned (but hasn't selected) the 'Safe Profile', and failing to get any of the user's other profiles, should assume the ‘G:Safe Profile’.
Circle one:  PASS  /  FAIL

M.6
After verifying that the expected results are received, logoff the system.

Circle one:  PASS  /  FAIL

N
Test ability of Safe Profile to exist with other profiles.



N.1
On Candidate Platform NIS Server, secman:

Add the 'G:SA_Default' profile and the UNIX group ‘other’ to user ‘gtest1’
Criteria:

Login name = gtest1
Default profile = <no change>
Assigned UNIX Groups = add other
Assigned Profiles = add 




G:SA_Default
No errors should be generated.

User 'gtest1' should have profiles  ‘G:Safe_Profile’ and ‘G:SA_Default’ assigned in the user-profile DB.
Circle one:  PASS  /  FAIL

N.2
On Candidate Platform NIS Server, sysadmin:
To view  the file NIS group file, type:


ypcat group | grep gtest1 <rtn>

(NIS+) niscat group.org_dir  | grep gtest1 <rtn>
NOTE:  Prior tests have shown it is also assigned to group admin by default.  Pending evaluation, this result is acceptable and should not preclude a PASS result for the test step.
User 'gtest1' should be a member of group ‘other’ in NIS group.
Circle one:  PASS  /  FAIL

N.3
On Candidate Platform NIS Server, sysadmin:

To view  the file NIS passwd file, type: 

ypcat passwd  | grep gtest1 <rtn>
(NIS+) niscat passwd.org_dir  | grep gtest1 <rtn>
User 'gtest1' default GID in NIS passwd should be 36.
Circle one:  PASS  /  FAIL

N.4
On Validation Host (NIS Client):

Login as user ‘gtest1’.


No errors should be generated.

User 'gtest1' should be able to launch applications from both profiles.
Circle one:  PASS  /  FAIL

N.5
Use the Profile Selector to select all of the available profiles.

Circle one:  PASS  /  FAIL

N.6
Launch applications from both the ‘G:SA_Default’ and ‘G:Safe Profile’ profiles.

Circle one:  PASS  /  FAIL

N.7
After verifying that the expected results are received, logoff the system.

Circle one:  PASS  /  FAIL

O
Test ability to add multiple users.



O.1
On Candidate Platform NIS Server, secman:
Create a new user 'gtest2' using the following criteria.
Criteria:

Scope = global

Login name = gtest2
Default profile = SSO_Default
Assigned UNIX Groups:

on Solaris = nobody
on HP-UX = nogroup
Assigned Profiles = G:SSO_Default
No errors should be generated.

User ‘gtest2’ should be assigned to the ‘G:SSO_Default’ profile in the user-profile DB.


Circle one:  PASS  /  FAIL

O.2
On Candidate Platform NIS Server, sysadmin:

To view  the file NIS group file, type:

ypcat group | grep gtest2 <rtn>
(NIS+) niscat group.org_dir  | grep gtest2 <rtn>
User 'gtest2' should be a member of the UNIX group ‘nobody’ in NIS group.
Circle one:  PASS  /  FAIL

O.3
On Candidate Platform NIS Server, sysadmin:

To view  the file NIS passwd file, type: 
ypcat passwd  | grep gtest2 <rtn>
(NIS+) niscat passwd.org_dir  | grep gtest2 <rtn>
User 'gtest2' default GID in NIS passwd should be 36.
Circle one:  PASS  /  FAIL

O.4
On Candidate Platform NIS Server, secman:
Create a new global user 'gtest3' using the following criteria.

Criteria:

Scope = global

Login name = gtest3
Default profile = SA_peon
Assigned UNIX Groups = <none>
Assigned Profiles = G:SA_peon
No errors should be generated.

User 'gtest3' should be assigned to the ‘G:SA_peon’ profile in the user-profile DB.


Circle one:  PASS  /  FAIL

O.5
On Candidate Platform NIS Server, sysadmin:
To view  the file NIS group file, type:

ypcat group | grep gtest3 <rtn>
(NIS+) niscat group.org_dir  | grep gtest3 <rtn>
User 'gtest3' should not be a member of any groups in NIS group.
Circle one:  PASS  /  FAIL

O.6
On Candidate Platform NIS Server, sysadmin:

To view  the file NIS passwd file, type: 
ypcat passwd  | grep gtest3 <rtn>
(NIS+) niscat passwd.org_dir  | grep gtest3 <rtn>
User 'gtest3' default GID in NIS passwd should be 36.


Circle one:  PASS  /  FAIL

P
Test users with multiple derivative profiles.



P.1
On Candidate Platform NIS Server, secman:

Create a new global profile 'SA_grunt' with account group ‘System Admin’ and assign some applications to it.

Criteria:

Scope: = global

Profile ID: = SA_grunt 

Account Group: = System Admin

Classification: = <no change>

Profile Lock: = <no change>

Applications: = assign several
If no errors are generated, the test result is PASS otherwise the result is FAIL.

The profile ‘G:SA_grunt’ should appear in the user-profile DB.


Circle one:  PASS  /  FAIL

Q
Test interactions of account groups.



Q.1
On Candidate Platform NIS Server, secman:
Add the ‘G:SA_grunt’ profile and UNIX group 'other'  to user 'gtest2'.

Criteria:

Login name = gtest2
Assigned UNIX Groups = add other
Assigned Profiles = add G:SA_grunt
No errors should be generated.

User 'gtest2' should have the ‘G:SA_grunt’ and ‘G:SSO_Default’ profiles assigned  in the user-profile DB.


Circle one:  PASS  /  FAIL

Q.2
On Candidate Platform NIS Server, sysadmin:

To view  the file NIS group file, type:

ypcat group | grep gtest2 <rtn>

(NIS+) niscat group.org_dir  | grep gtest2 <rtn>
User 'gtest2' should now be a member of the 'other' group in  NIS group.
Circle one:  PASS  /  FAIL

Q.3
On Candidate Platform NIS Server, sysadmin:

To view  the file NIS passwd file, type: 
ypcat passwd  | grep gtest2 <rtn>
(NIS+) niscat passwd.org_dir  | grep gtest2 <rtn>
User 'gtest2' default GID in NIS passwd should be 36.
Circle one:  PASS  /  FAIL

Q.4
On Validation Host (NIS Client):

Login as user 'gtest2'


No errors should be generated.

User ‘gtest2’ should be able to launch applications from both profiles.
Circle one:  PASS  /  FAIL

Q.5
Use the profile selector to activate both the ‘G:SA_grunt’ and ‘G:SSO_Default’ profiles.

Criteria:

Login name = gtest2
Assume Profiles = SA_grunt and SSO_Default

Circle one:  PASS  /  FAIL

Q.6
After verifying that the expected results are received, logoff the system.

Circle one:  PASS  /  FAIL

R
Test session manager's ability to resume the previously active set of profiles.



R.1
On Validation Host (NIS Client):
Logout of system, and log back in as user 'gtest2' 
Criteria:

Login name = gtest2
No errors should be generated.

User ‘gtest2’ should have both the ‘G:SA_grunt’ and ‘G:SSO_Default’ profiles available.
Circle one:  PASS  /  FAIL

R.2
Examine the application manager to (or use the profile selector) to determine the profiles that are available.

Circle one:  PASS  /  FAIL

R.3
After verifying that the expected results are received, logoff the system.

Circle one:  PASS  /  FAIL

S
Test ability to login with NO available profile.  Delete user's only (and default) profile.

 

S.1
On Candidate Platform NIS Server, secman:
Deassign the ‘G:SA_peon’ profile from user 'gtest3'.  

Criteria:
Login name = gtest3
Assigned Profiles = deassign  



G:SA_peon
No errors should be generated.


Circle one:  PASS  /  FAIL

S.2
On Validation Host (NIS Client):
Login to system as user ‘gtest3’. 
No errors should be generated.

User ‘gtest3’ profiles previously used are unavailable and the ‘Safe Profile’ has not been assigned.  Therefore, the session manager should log the user in with no available profile.  
Circle one:  PASS  /  FAIL

S.3
After verifying that the expected results are received, logoff the system.
The DII_Apps window should not have any available profile folders.

The profile selector should show that user ‘gtest3’ has no available profiles.
Circle one:  PASS  /  FAIL

T
Test ability to detect two users with the same login name in the same scope.



T.1
On Candidate Platform NIS Server, secman:
Create a new user 'gtest2' using the following criteria.

Criteria:
Scope = global
Login name = gtest2
Default profile = SSO_Default
Assigned Profiles = G:SSO_Default
Should receive error message “duplicate user name”   (since the user 'gtest2' has already been defined)

Action should NOT have altered any of the UNIX group or user-profile database files.
Circle one:  PASS  /  FAIL

U
Test ability to detect two profiles with the same name in the same scope.



U.1
On Candidate Platform NIS Server, secman:
Create a new global profile 'SA_peon' using the following criteria.

Criteria:
Scope = global
Profile ID = SA_peon
Account group = System Admin
Should receive error message “duplicate profile name.  Profile ‘SA_peon’ was not added”    (since profile ‘SA_peon’  has already been defined).
Action should not have altered any of the UNIX group or user-profile database files.
Circle one:  PASS  /  FAIL

V
Test ability to detect two UNIX groups with the same name in the same scope.



V.1
On Candidate Platform NIS Server, secman:
Create a new global UNIX group 'admin' using the following criteria.

Criteria:
Scope = global 
Group name = admin
Group number  = <assigned by security manager>
If expected error is generated, the test result is PASS, otherwise the result is FAIL.

Should receive error message “duplicate group name” (since the UNIX Group 'admin' has already been defined).


Circle one:  PASS  /  FAIL

V.2
On Candidate Platform NIS Server, secman:
View user information from COE Secman,        Security Manager: View > Users > Global scope.
Action should NOT have altered any of the UNIX group or user-profile database files.

Ensure that duplicate users ‘gtest2’ do not exist.


V.3
On Candidate Platform NIS Server, secman:

View user information from COE Secman,        Security Manager: View > Unix Groups > Global scope.
Ensure that duplicate groups ‘admin’ do not exist.


Circle one:  PASS  /  FAIL

W
Reset Test Cell to Original condition.



W.1
Cleanup files generated during test execution.



W.2
On Validation Host NIS Server, secman:

Delete all local and global user accounts, profiles, and groups that were generated during test execution.
No errors should be generated.
Circle one:  PASS / FAIL

W.3
On Candidate Platform NIS Server, secman:
Delete all local and global user accounts, profiles, and groups that were generated during test execution.
No errors should be generated.
Circle one:  PASS  /  FAIL

X
Remove NIS



X.1
NOTE:  Be sure to remove NIS from the NIS client first.
On the Validation Host as sysadmin:
Remove NIS from the Validation Host (NIS Client).  Select,
Network > Servers > Set NIS > Remove NIS 
and follow the instructions for removal of NIS.
No errors should be generated.

Save global user?  
No

Reboot?

Yes
Circle one:  PASS  /  FAIL

X.2
On the Candidate Platform, as sysadmin:

Remove NIS from the Candidate Platform NIS Server (NIS Master).  Select,
Network > Server > Set NIS > Remove NIS
and follow the instructions for removal of NIS.
No errors should be generated.
Circle one:  PASS  /  FAIL

Y
Unmount/Unexport all remotely mounted file systems.



Y.1
On the Candidate Platform, as sysadmin:

Unmount /h/USERS/global from the NIS Client.   Select,

Hardware > Disk Manager
The Disk Manager window appears.
Circle one:  PASS  /  FAIL

Y.2
Highlight the file system with the name of the NIS Master in front of 
/h/USERS/global
The appropriate file system is highlighted.
Circle one:  PASS  /  FAIL

Y.3
Select [UNMOUNT] from the bottom of the window.
As expected (or if any boxes appear, click [YES] and continue).
Circle one:  PASS  /  FAIL

Y.4
Click [OK] to confirm.

Circle one:  PASS  /  FAIL

Y.5
Log off the Validation Host.


Circle one:  PASS  /  FAIL

Y.6
On the Candidate Platform, as sysadmin:

Unexport /h/USERS/global from the NIS Master.   Select,


Hardware > Disk Manager
The Disk Manager window appears.
Circle one:  PASS  /  FAIL

Y.7
Select [EXPORTFS] from the bottom of the window.
The Export/Unexport File Systems window appears.
Circle one:  PASS  /  FAIL

Y.8
Type the pathname:  /h/USERS/global and click [UNEXPORT] to continue.
As expected (or if any boxes appear, click [YES] and continue).
Circle one:  PASS  /  FAIL

Y.9
Click [OK] to confirm.

Circle one:  PASS  /  FAIL

Y.10
Click [YES] to permanently unexport the file system.

Circle one:  PASS / FAIL

Y.11
Click [OK] to confirm.

Circle one:  PASS / FAIL

Y.12
Select [EXPORTFS] in the Disk Manager window.
The Export/Unexport File Systems window appears.
Circle one:  PASS  /  FAIL

Y.13
Select [CURRENT] in the Export/Unexport File Systems window.
/h/USERS/global should NOT appear as one of the directories listed as being exported.
Circle one:  PASS  /  FAIL

Y.14
Logout of sysadmin.


Circle one:  PASS  /  FAIL

Z
Logout (Optional)
Not required.  Use if no further validation is to be done.



Z.1
Unmount the KPC directory exported from the Validation Host.  
Type:

 “umount /home1/KPC”

Not required.  Use if no further validation is to be done.
A message confirms that the filesystem has been dismounted.
Shutdown

Z.2
Select, System > Close All

Not required.  Use if no further validation is to be done.
All windows close.
Shutdown

Z.3
Select Exit button from CDE.

Not required.  Use if no further validation is to be done.
Logout confirmation window appears.
Shutdown

Z.4
Select, Continue Logout
Not required.  Use if no further validation is to be done.

System exits and the DII COE login screen appears.
Shutdown

End of Accounts & Profiles - Global G1 Validation Procedure
Appendix A: Setting up a Sun Solaris machine as an NIS Client

The following procedures should be done in order, for the NIS Initialize procedures for an NIS client to work properly:

NOTE:  The following steps refer to Server as NIS Server and Client as NIS Client (NOT VALIDATION HOST AND CANDIDATE PLATFORM).

1. Server:  Select  > Network > Servers > Set NIS > Add NIS Client:  Add the NIS Client to the NIS Master.

2. Server:  Reboot at this time.

3. Client:   Login as sysadmin and in an X-term window, FTP all files from the Server’s /var/nis directory to the client’s /var/nis directory.

4. Client:  Select Network > Servers > Set NIS > Initialize NIS:  To initialize NIS as a client. (Reboot at this time).

5. Server:  From an X-term logged in as ‘root’:  Type nisgrpadm –l admin to check for proper spelling of both NIS Server and NIS Client.

NOTE:  The spelling for both the Server and client should appear CORRECTLY as an Explicit Member from the output of the command issued in Step 5.

6. Server:  From an X-term Logged in as ‘root’:

If the listing for step 5 is not accurate use the following commands to correct the problem:

             TO REMOVE A CLIENT/USER FROM THE EXPLICIT MEMBER LIST:


nisgrpadm –r admin.<nis domain name>.  <client/user name>.<nis domain name>




where r = Remove from list of explict members

TO ADD A CLIENT/USER TO THE EXPLICIT MEMBER LIST:



nisgrpadm –a admin.<nis domain name>.  <client/user name>.<nis domain name>




where a = Add to the list of explict members.

NOTE:  This will work IF NIS is initialized properly.

END OF APPENDIX A
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